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2 FERAGSITIAERAA

AliOS Things fEw 21 aos-cube T H52)ERGiH A,

&R

TFHEIFREE Python 2.7,

(]

L4 aos-cube

%, JH python 5B pip K%&d aos-cube, HEtZ{EMEH] Python 35Sy, W Conda

, virtualenv,

$ pip install aos-cube

BimA:
WHHIA pip BT Python 2.7 ), QURBZEERME, WM --user 28, HKES% pip

install Fiko
THABHERIRRITET
AR Developer Kit
- AlOS ThingshiA7E2.1.0.2, JBHELW T,

git clone https://github.com/alibaba/Ali0S-Things.git -b <release_br
anch_name>
cd AliO0S-Things
aos make helloworld@developerkit # e
C. PR
aos upload helloworld@developerkit # [Effkést
TN

- AliOS ThingshiiAf£2.1.02)5, BIiHLWT,

gitclone https://github.com/alibaba/Ali0S-Things.git -b <release_br

anch_name>
cd Ali0S-Thingsaosmakelinkkitpp@developerkit -c config #EAC B R

FHiapp

aos make #omEr e (. . . eI RE)

aos upload #ERERERE (. . BEStITRE)
BLH:

- -b <release_branch_name>igHEBBMA S, wPLZ%4#unique 5/
unique 5 Connect_42_section_mu6_bsk tt7

- WP -b <release_branch_name>, ZRIN PEIRWIRA,


https://packaging.python.org/tutorials/installing-packages/
https://packaging.python.org/tutorials/installing-packages/
https://github.com/alibaba/AliOS-Things/wiki/Developer-Kit-Tutorial

£0log® R

B IFEEIF RN, WEAE MW app_delayed_action fE1#1)E2h, 5% —X, AlOS
Things 3.0.0fAKlogl MR,

Welcome to Ali0S Things
nano entry here!

hello world! count 0
hello world! count 1
hello world! count 2
hello world! count 3
hello world! count 4
hello world! count 5
hello world! count 6
hello world! count 7
hello world! count 8
Bl
FIALOS ThingsliANAR], logHEWMA R,
9 ZRPREIES S
+ blink
* mgttapp

+ linkkitapp


https://github.com/alibaba/AliOS-Things/tree/master/app/example/blink
https://github.com/alibaba/AliOS-Things/tree/master/app/example/mqttapp
https://github.com/alibaba/AliOS-Things/tree/master/app/example/linkkitapp

3 /& AliOS Studio (Visual Studio Code)

A S HALOS StudioBKPFi 2% B 75 i,

AliOS StudiofE—EH ¥ vscode
T
1. P&/ &%vscode,

Vil https: //code.visual studio.com/
2. ‘ZHALIOS Studiofdift,

1 vscode, &M PRI EHEALIOS Studiofdiff,

File Edit Selection View Go Debug Terminal Help Extension: alios-studio - doc - Visual Studio Code

v  censindics S\ alios-studio

alios-studio
levelopment alios &> 13,000 ' & 8 & & ¢

Inetall ial IDE for Alif opment

al Studio Co - - Sosaky 3 ﬁﬁ
Install LAY

Visual Studio Light1 Th Details ions Changelog
MY Visual Studio Light1 Theme

wengquansun

\fisual Studio Team Servi... 120 Alios Studio README

The official IDE for AliOS Things development

Features

1. Language support for C includes Auto-completion, Symbol searching, Go to/Peek Definition/Declaration, etc.
2. Create AliOS Things Project with easy-to-use example.
Opsens iy Visas] Stuelio 1 3. Compile and upload image to AlOS Things Boards.
n the current file in Vi 4. View serial port log and intereact with di in AliOS Things Boards.
abhiagr 5. Debug AliOS Things Boards with GUL

jamiewest

PeachPie for Visual ...
xtension for Peac...
Install

OUTPUT

Jeppe A
Angular 1.x snippets .

.':. LanguageTool for Vi
LanguageTool gramm

Pmaste & QO0AO Olnihalizingﬁﬂ'slanguaigefeamrs



https://code.visualstudio.com/
https://code.visualstudio.com/

3. 4 aos-cube,

AliOS Studioffifiiaos-cube, WIRBETFF)LPaos-cubeltyif, %% Waos-cube,

LR
AliOS-Studio—# %% aos-cube R ZHAEE I python A B Y (virualenv

fERA
1. AliOS-Studio T.HF%,

AliOS-Studiof) EEIREARHE P fEvscode FI5 TRFA D, /bR A Z A DRE TN i
B bk, HBOTTH, QBETHE. Wk


https://docs.aliosthings.io/documentation/tools/aos-cube
https://virtualenv.pypa.io/en/latest/

2. %ii¥ - Build

EMhelloworld@starterkit@ il Hbs, HUEIEN @ HbsiA R, silie
W PMRUGESER A HAMR, 25 01 PSRBT iR



3. k&3t - Upload

a. jlild USB Micro LREEFEHEAFIF R B rLfin,
b. Hdi )5 TR RE SRS HER

file Edit Selection View Go Debug Terminal Help Lc - AOS-Things - Visual Studio Code

EXPLORER helloworld.c x
4 OPEN EDITORS
x helloworld.c
4 ALIOS-THINGS
» Iy github
e'<aos/aos.h>

_name( });

> B include
B kemel
>
® platform i] | on, *NULL);

5

m utilty

TERMINAL alios-studio: U ¥
-gitignore

e/github/A1105-Things/build/cmd/wi
1

: Loading device
@ ucube.py 2 N 0 Device connel

Attempting to write 110776 (@x1b@b8) bytes to stm32 address: 1342177
28 (0x8000000)
b OUTLINE Flash page at addr: ©x08019800 erasedEraseFlash - Page:0x33 S 0
Pdeveloper 50131 Q helloworld@developerkit  # A& 0 O0AD®2 X1 application start{int arge, char *argvll)  In 16,Col 19 Spacesd UTF8 CRIF € Win32 @ A

4. ke - Monitor

a. jlijd USB Micro £REEHEHELFIT R LI
b. i B THESESLEFTFR O, B REESPORAS BORAANPEE, AL
nf LA SR O, [ a) PAEIX U\ i 2 EF T 28 L
5. Wik

WEEHEPB: [ A0S Sudio JE4g AliOSThings Jfito


http://v.youku.com/v_show/id_XMzU3OTE5ODE1Ng==.html

4 Boh&E X Keil MDK Iz

A BB R R R Keil T2,
HEETE
- RHEKeEl,

- Bmkeili¥toolchain g2 #lwindowsH3F5i2 H Path b,

BE:
keilftjtoolchaindg 28RN MC: \Keil v5\ARM\ARMCC\bin, XTFUHIZMAEBRIESW

How to add a folder to Path environment variable
4 Rkeil T#2
A3 B gk khelloworld @developerkitifkeil T2,
1. T ras %, HidEmRkeil T,

// v2.1.02)5
aos make IDE=keil

// v2.1.02ZHi
aos make helloworld@developerkit IDE=kei'l

2. ¥ERMkeil LFEHSF{#fEprojects/autogen/helloworld@developerkit/
keil_projectXfF¥h, HEXPENZUT,

$ tree helloworld\@developerkit/

helloworld@developerkit/

[ keil_project
helloworld@developerkit.uvoptx
helloworld@developerkit.uvprojx
opts

armv7m.ar_opts
(more...)
yloop.c_opts

£ Keil IDE4RiIZLHE

1. # Aprojects\autogen\helloworld@developerkit\keil_projectHs%, FJIF4mK
keil L#thelloworld@developerkit.


https://www.keil.com/download/product/
https://stackoverflow.com/questions/44272416/how-to-add-a-folder-to-path-environment-variable-in-windows-10-with-screensho
https://stackoverflow.com/questions/44272416/how-to-add-a-folder-to-path-environment-variable-in-windows-10-with-screensho

2. WIMBER

a. &P Project > Options for Target 'helloworld@developerkit', I LHBEHE.

4 Dicodeviot\aos\develop\AlIOS-Things\projects\autogeni\helloworld@developerkit\keil_project\helloworld@developerkit.uvprojx - pVision
File Edit View [Project | Flash Debug Peripherals Tools SVCS Window Help

S A d|
&

'roject
=% Project: he
%7 hellow
&1 aty

i

=
i
(=}
5]

Fe i B B B 8]
PEOEOEOE W OE RO E
2232883738 %

%,

New pVision Project...

New Multi-Project Workspace...
Open Project...

Close Project

Export
Manage

Select Device for Target ...

Remove Ttem

Options for Target 'helloworld@developerkit'...

Clean Targets

Build Target

Rebuild all target files
Batch Build

Batch Setup...
Translate...

Stop build

b. fEDevice 5 EFA MK Device,

Options for Target 'helloworld@developerkit'

Device | Target | Output | Listing | User

|Soﬁware Packs

Vendor: STMicroelectronics
Device: STM32L475VGETx
Toolset ARM

Search: stm321496vgx

3
»
Alt+F7
F7
Ctrl+F7
1 Dvradalinti anct dovral anl AlINIC_Thinach nrniactel autanant hallrunrd@ davalanarlkits bail nrniactthall msearld@ Aaualanarkit Dnoneaiv
|
|c/c++ |hsn | Linker |Debug |Utilities|
Software Pack
Pack: |Keil. 5STM32L4xx_DFP.2.0.0
URL:  http:/fwww. keil. com/pack
5T has built a new architecture to reach bestin-class ultra-low-power -

=% STMicroelectronics
B STM32L4 Series
B STM321496

B STM32L496VG

€ STM32L496VGTx

figures thanks to its high flexibility.

STM32L4 MCUs have scored 176.7 in the standardized EEMBC

ULPEBench tests that compare the efficiency of ultra-low-power
microcantrollers.

Mareover, the STM32L4 series shatters performance limits in the ultra-
low-power world.

It delivers 100 DMIPS based on its ARM Cortex-M4 core with FPU and ST |=
ART Accelerator at 80 MHz.

STM32L4 microcontrollers offer dynamic voltage scaling to balance power
consumption with processing demand, low-power peripherals (LP UART,
LP timers) available in Stop mode, safety and security features, smart and
numerous peripherals, advanced and low-power analog peripherals such
as op amps. comparators, LCD, 12-bit DACs and 16-bit ADCs (hardware

-

K

Defaults

Help

Cancel




3. PHIABEHE,

FIOFTREBEE, %EHDebugii®, HUESHIARIESMHMMdebug TH, #i
ideveloperkitJF BB IEEEST-Link Debugger, WINEMiR,

Options for Target 'helloworld@developerkit’ @
Device | Target | Output | Listing | User |C/C++ |dsm  |Linker Debug ]Utilities |
(" Use Simulator with restrictions Settings @ Use: JULINK2/ME Cortex Debugger ﬂ Settings |
[~ Limit Speed to Real-Time ULINK2/ME Cortex Debugger -

ULINK Pro Cortex Debugger

L . ULINKplus Debugger
[v Load Application at Startup [+ Runto main() [v LoadA "MSIS-DAP Debugger

Initialization File: Initializatio|U-LINK / J-TRACE Cortex =

Models Cortex-M Debugger
J ST-Link Debugger

ain()

PEMicro Debugger

Restore Debug Session Settings Restore

ULink Debugger
[v Breakpoints [v Toolbox [v Breotellars ICDI
P i SiLabs UDA Debugger -
[v Waich Windows & Performance Analyzer [v W acrvmmdons —
[v Memory Display [v System Viewer [v Memory Display [v System Viewer
CPUDLL: Parameter. Driver DLL: Parameter.
|S}-\RMCM3.DLL | -REMAP -MPU |S}-\RMCM3.DLL | -MPU
Dialog DLL: Parameter: Dialog DLL: Parameter:
|DCM.DLL |-pCM4 |TCM.DLL |-pCM4
[ Warn if outdated Executable is loaded [ Warn if outdated Executable is loaded

Manage Component Viewer Description Files ... ‘

0K | Cancel Defaults ‘ Help

@ Bi:

1ERES %G, TEEAEDebug B PACE TH, &0 MBS KIBIK e,
e TR R PRI eR AR B G, WD keiDRFE, K5 IESMIRIA Y .



5 BohERL IAR Iz

AL BB I IETIAR T
HEEITE
- PEEZHIAR Embedded Workbench
- WIMIARMtoolchainif2#lwindowsFEFBE 2 B Pathi,
il
= Bim:
IARtoolchain¥ 2 BRiIANMC: \Program Files (x86)\IAR Systems\Embedded
Workbench 8.0\arm\bin., XTFUWZIMIAEEZE RIS WHow to add a folder to Path

environment variable,
4 RIARTE
AR p 3 E A gk sk helloworld @developerkit I TAR T2,
1. $UTU P2, HFERIAR LR,

/] v2.1.0%2)E

aos make IDE=diar
// v2.1.0 2540
aos make helloworld@developerkit IDE=iar

2. BERMIARTLFEHS i fEprojects\autogen\helloworld@developerkit )\
IAR_projectXfE¥kvh, HEXHFMNZEUIR.

fEFIAR IDE4RIFIEIA T2
1. ITARFTIF L,

WAprojects\autogen\helloworld@developerkit\IAR projectHzt, RENAFNI
helloworld@developerkit, X{FIMMworkspaceWISFE, Mdii XIFRIm AHIARE

AT IF TR
=R v {EpCHEE it N
opts 2018/11/28 15:58 =ridsE
helloworld@developerkit.ewd 2018/11/28 15:56 EWD 2% 97 KB
helloworld@developerkit.ewp 2018/11/28 15:56 EWP {4 243 KB
9| helloworld@developerkit 2018/11/28 15:56 IARIDE Workspa... 1 KB
utility_digest_algorithm_crc 2018/11/28 15:56  C3zif 2KB


https://www.iar.com/iar-embedded-workbench/
https://stackoverflow.com/questions/44272416/how-to-add-a-folder-to-path-environment-variable-in-windows-10-with-screensho
https://stackoverflow.com/questions/44272416/how-to-add-a-folder-to-path-environment-variable-in-windows-10-with-screensho

ToTY M PRI ER S Poidors / 5 BB TAR T

2. fIF LAEEEL

FIF LG, % Project > Options for node 'helloworld@developerkit', ¥JJF L%
.

Add Files...
Add Group...
[ | import File List...

Add Project Connection...

Files Edit Configurations...
B @helloworld@
@ Warmv?m | % Remove
alparser
— Bl auto_comp T | Create New Project...
e i A | Add Existing Project...
debug
developer] [g Options... Alt+F7
device_sal

—H M digest_alg Version Control System

@ i hal

@ s helloworld | @ Make F7

kernel_int| | | compile Ctri+F7
@ Rebuild Al
& Clean
& Batch build... 2:]
(C-STAT Static Analysis »

Stop Build Ctrl+Break
| 6 =t 321dvr

Q
rhe\\nwnr\d@deve © Download and Debug Ctrl+D
F » | Debug without Downloading ﬁ
i, L3 ~ hd
¥) | Attach to Running Target
Log ® | Make & Restart Debugger Ctrl+R
ton Dec 03, 21 a rogram Files (xB6)\AR Systems\Embedded Workhench & 0harmibin\armproc.dll)
Restart Debugger Ctri+Shift+R
Download 4
SFR Setup
CMSIS-Pack 4
Open Device Description File »
Save List of Registers...
Edit options for the selectea item - AB ¥ s B

12 ScRiA : 20191114



3. EFEFMdevice,

ikFtgeneral options > Target > Device, RJGIEHERHRE)Y, WIR]PAETARE Szt 1.
EO

Options for node "helloworld@developerkit” @

Categony.

General Options

Static Analysis

Runtime Checking | Library Options 2 | MISRA-C:2004 |  MISRA-C:1998
C/C++ Compiler Target Output | Library Conflsuration | Library Options 1
Assembler
Output Converter Processor wvarlant
Custom Build ) Core Cortex—IN4 b
fi:'z:““"“s @ Device ST STH32ZL496VG
Debugger ) CMSIS-Pack 1°7°
Simulator
CADI Endian mode Fleoating peint settings
zs:f;:: @Little FPU |VFPv4 single precisi. v
I4et/ITAGjet Ble
JHlink/]-Trace ERzz 1o T
I Stellaris @/ BES
PE micro Advanced SIND (NEON
STLINK DSP Extensien
Third-Party Driver
TI MSP-FET
TIXDS

| ok || Cancal |

Fit, AliOS ThingsfE—YPuBifIFERNIAR TRECE v sesE, JFRE W RIEstILaE EAEHIAR
IDERSE I E 2 IIHE,



6 £ RKIAR/KEILTAZE Il [n) &R

6.1 AR & FFEkkeil/IARTEE
Sk kel /IAR TR IIHIGLLA; 35

A A
A pkkeil /IAR TR,
E] AR
LI R board Ha NMTIF. mkx(fF, BARSHUTHNE, HARDESE,

ifeq ($(COMPILER), armcc)

S (NAME) _SOURCES += startup_stm321496xx_keil.s
else ifeq ($(COMPILER), iar)

$(NAME) _SOURCES += startup_stm321496xx_1iar.s
else

$ (NAME) _SOURCES += startup_stm321496xx.s
endif

ifeq ($(COMPILER),armcc)

GLOBAL_LDFLAGS += -L --scatter=board/developerkit/STM32L496.sct
else ifeq ($(COMPILER),diar)

GLOBAL_LDFLAGS += --config board/developerkit/STM32L496.1icf
else

- W A, Fore R EKeil /IARTFE
< WERBEE, WA R Keil /IAR TN B, sekkeil /TAR TR SZRSCARRI G,

6.2 L6218E: Undefined symbol _Heap2Base (referred from
soc_impl.o)
L6221 SEFL R B M Undefined symbol _Heap2Base (referred from
soc_impl.o)i}, WifAILLRE,

o) R

L621SEFREIDHMEE : Undefined symbol _Heap2Base (referred from soc_impl.o)
A AR

TIRALIOS ThingsBHUR PRI BIIRCEPEIHE, FIBRSIRYDL. SCRIBRINEUT.

2.2.6.3 WEEHHERACE
MR A HSE DI RE, WIS RSTIFRHINO_CONFIG_MM_TLF%, SRAEREK_mmEi, J HAC
EO R HESE )



HER W) A =R BERAIAGSE L, LG X, BEE L, HERA Tk REHIIAIASE S
AR A B — A2 RV HEE I, P28 g _mm_regioniE Rl

Zh8 R 2 hsoc_impl.c XA EFACISEK, Zsoc_impl.c XN R,

extern void *__HeapBase;

extern void *__HeapLimit;

extern void *__Heap2Base;

k_mm_region_t g_mm_region[] = {

{(uint8_t x)&__HeapBase, (uint32_t)0x8000},
{(uint8_t x)&__Heap2Base, (uint32_t)0x8000}
5

int g_region_num = sizeof(g_mm_region)/sizeof(k_mm_region_t);

0] DU RSO, Bsoc_impl.c XPFM. sctXPR DL, tan] PUE B & SCRL Shise S
TiiEETIE, RS Wplatform/mcu/stm3214xx_cube/aos/soc_impl. cJsik,

BE:
Hersh gt 2nBsINREr mE, el 2 WYL LR AT RO,

6.3 armcc: not found
FrarmecB R i S B not foundiby, aidkag
IR AR
armcciiR#bE R : not found,
IR R

#EMmkeilbin HZIABE R, HIEIESE a4 )kKell MDK T8 > i T4

6.4 C3903U: Argument '/hardfp' not permitted for option 'apcs'

AEIC3903UHE R s B MArgument '/hardfp' not permitted for option 'apcs'if, i
31

o) R
C3903UHmHIDHMEE : Argument '/hardfp' not permitted for option 'apcs’,
0] R ARR

keil BTN, P CABASCRHZ RO, Eltkeills, BISED.
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